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A comparison of Reporting Services and SQL-RD 

 

If you are looking for a web-based solution which allows users to generate and view reports themselves on the 
internet or intranet, then Reporting Services is the one for you.  In addition to this, Reporting Services has some 
basic scheduling functionality which allows you to schedule reports to be exported and delivered at defined 
intervals. 

If you are looking for a scheduling tool which will run your reports from multiple RS installations, export them to 
multiple formats and deliver them to multiple destinations then SQL-RD is the one for you.  SQL-RD 
concentrates on the scheduling and delivery aspects of your total report distribution solution. It is not a web 
based solution. 

Many users use Reporting Services to provide web-based ad-hoc reporting capabilities to their staff and clients, 
but use SQL-RD to push reports into the in-boxes, printers, ftp sites etc in more formats and with greater 
flexibility than Reporting Services allows. 

The two products work well together.  When reading the comparison of SQL-RD and Reporting Services below it 
is important to remember that only the report scheduling and distribution capabilities of the two products are 
being compared. 

Disclaimer: 

This comparison is based on our experience of Microsoft SQL Server Reporting Services 2005 as well as what 
other users have reported to us. It is compared with the Evaluation Edition of SQL-RD.  Because the comparison 
is written by us, it is subjective.  The document should be read in this context.  If you find an inaccuracy please 
send an email to sales@christiansteven.com and it will be corrected within 24 hours.  You must not purchase 
one or other product based on the comparison below alone.  You must test out both products 
thoroughly to find out which one (or if both) is suitable for your business and your needs.  
ChristianSteven will not accept responsibility for any business decisions made by you based on this comparison 
under any circumstances. By reading the comparison you agree to this statement.  

 

  Reporting Services SQL-RD 

General 

Q: What are the basic hardware/software requirements? 

A: You require Windows 2000 or 2003 Servers.  IIS 
must be installed and configured.  The server must 
have access to the internet and a suitable firewall 
must be installed to allow users in and keep 
everyone else out. 

SQL-RD will work on Windows 2000 Server and 
Workstation, Windows XP, Windows NT Server, 
Windows 2000 and 2003 Servers, and Windows 
Vista.  So it will work on PCs as well as servers. 

  
Q: How many users can be logged on simultaneously 

A: Up To the CAL you have purchased Because users only log on to write schedules and 
administer other automation functions, SQL-RD is 
licensed per installation, not per user.  If, for 
example, it is installed on 1 server, there is no limit 
to the number of people who can log on and use it. 
The number of installations you can have is 
dependent on the license you own, but there is no 
limit to the number of clients that can connect 
concurrently to the same scheduling database - 
save for the limit set by your database server. 

  
Q: Will it work with my MS Exchange Server? 

A: Yes. The Exchange server will need to be configured 
so that it will accept SMTP relay from the Reporting 
Services machine. If this isn't acceptable to your 
SMTP server administrator, then you will need to 
identify a SMTP server that you can access.  

Yes.  The Exchange server does NOT have to be 
configured for SMTP.  If you wish (and lets face it, 
it’s what most email administrators prefer), SQL-RD 
simply integrates with the Exchange server silently.   

This means that you can use your Outlook and 
Exchange address books and the emails are subject 
to all the system policies set up in Exchange by your 
email administrator. 
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If you cannot or prefer not to use an internal SMTP 
or Exchange server, you can simply use SQL-
RDMail, which is ChristianSteven's own SMTP 
server.  Its free! 

  

Email 

Q: Can I send one recipient an Excel Worksheet and another a PDF Acrobat document? Similarly can another 
user receive a Word document etc?  

A: You would have to write three subscriptions for this Yes.  Create as many "Destinations" as you like.  
Select a different output format for each destination. 
If you want 1 recipient to receive 10 reports of 
different formats, but all in the same email, then set 
up a "Package" 

  

Q: My report is processed but the email message isn't received 

A: There may be several reasons for this.  
 
• Use Server/View STMP log and see if anything 
obvious is revealed in the discussion with the SMTP 
server.  
 
• You may need to increase the timer value in the 
SMTP configuration form.  
 
• Increase the timer value in steps of 10 to see what 
setting works on your site 

There may be several reasons for this depending on 
whether you are using SMTP, MAPI, GROUPWISE or 
SQL-RDMail. 
 
• Use System Monitor -> Error Log to see if 
anything is revealed.  If you are using the Windows 
service integrated with Exchange server, your 
Windows Event Log may also show some 
messages.  Check the Email log to see if SQL-RD 
thinks it actually did send the email. Check the 
Email monitor to see if the email is still in the queue 
waiting to go. 
 
• You may need to increase the SMTP timeout. Go 
to Options -> Messaging and increase the timeout 
value. 
 
• In Options -> Messaging, check the options "Retry 
failed mails".  This option ensures that if anything 
happens to your mail server, SQL-RD will keep 
trying until the server is back on line.   

  

Q: What mail server and clients does it work with?  
For instance, can I receive reports sent to my email? I am using Outlook.  

A: Reports are emailed only by SMTP.  
However any email client eg Outlook, Outlook, 
Outlook Express, Pegasus Mail, Lotus Notes, can 
view the reports sent from Reporting Services.  

SQL-RD uses its own SMTP server (SQL-RDMail), 
your SMTP server, your GROUPWISE server or your 
MAPI compliant server e.g Outlook or Exchange.  

 - Emails can be viewed by all known email clients.   

- There is support for Japanese character sets. 

  

Q: Can I embed the report into the email instead of sending it as an attachment? 

A: Reporting Services cannot do this - If you are using SMTP  or SQL-RDMail you can 
embed the report into the email as part of the email 
body instead of as an attachment.  These emails can 
be read by all email clients which can read HTML 
emails. 

  

Q: I've created a list of email addresses so I can email a report to multiple people. Where do I put the name 
of the list file?  

A: Reporting Services cannot do this There is no programming to do.  Simply select the 
"text file" option and browse to your file.  SQL-RD 
does the rest. 
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Q: Can I pick the email address from a database? 

A: Reporting Services cannot do this There is no programming to do.  Simply select the 
"database" option and follow the wizard.  SQL-RD 
does the rest. 

  

Q: I want to know when the email has been delivered and when the recipient has read it. 

A: Reporting Services cannot do this Yes.  SQL-RD can do this if you are using 
Exchange/Outlook. 

  

Q: I want to send a report to my manager and another party. I need to do this for many reports. How do I 
send the report to two email addresses?  

A: The current version supports multiple email 
addresses separated by semi colons (;) 
CC and BCC functionality is also available.  These 
have to be typed into the email template.  

SQL-RD allows you to enter email addresses into 
"to", "CC" and "BCC" fields. 

-Separate email addresses using semi-colons. 

-Simply pick multiple email addresses from your 
Outlook/Exchange address book or from SQL-RD's 
own Internal Address Book. 

- Pick distribution groups from your 
Outlook/Exchange address book or from SQL-RD's 
own Internal Address Book. 

- Use a SQL statement to define your list of email 
addresses right out of any odbc compliant database. 

- Select a standard text file which has email 
addresses in it using a standard windows browse 
dialogue.  SQL-RD knows what you have selected 
and programming is required.. 

- Use a mixture of the above. 

  

Other Destinations 

Q: Apart from email, what other output destinations can I send reports to? 

A: - Disk folder (but only local to the RS server) 
  

- Disk Folder (including network shares) 
- Printer 
- FTP 
- FAX 
- Secure FTP 
- SMS (Cell phone text) 
- File transfer via RAS to a remote PC 

  
Q: Can my report create a unique file name each time it runs?  

A: Yes, but without the extended customization that is 
available in SQL-RD 
 
  

Yes.   

- You can do this by using the Date Stamp Feature.   

- You can also use the "Naming" module to change 
the name of the output file to whatever you want 
using SQL-RD Constants. 

- You can also give your exported file a different 
extension to what Reporting Services normally gives 
it.  e.g. an RTF output can be given a "DOC" 
extension to make it more easily recognizable by 
the recipient. 
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- Works with email, ftp, and disk outputs. 

- Does not apply to printer and SMS (cell phone 
text) outputs. 

  
Q: Can I direct the report output to an FTP folder? 

A: No Yes.  SQL-RD includes simple and complex FTP 
functionality.  Do it with a couple of clicks.  You can 
also send to a SecureFTP destination. 

  
Q: Can I do bulk printing? (One report to many printers) 

A: No Yes 

  
Q: Can I send one report to many folders without having to rerun the report each time? 

A: No Yes 

  
Q: Can I PGP encrypt the resulting file? 

A: No Yes 

  
Q: Can I have the schedule run now but be delivered in 2 hours time? 

A: No Yes 

  
Q: Can I compress (Zip) the resulting file before delivery?  And can I use Zip security to encrypt the resulting 

zip file? 

A: No Yes, you can do both 

  
Q: I want to clear out reports from the destination folder that are older than 1 month. How do I do this? 

A: Reporting Services cannot do this You can do this using the Folder Housekeeping 
option. 

  
Q: Do I need to have a FAX modem connected to the PC? 

A: You cannot FAX with Reporting Services If you have a FAX modem you can select this and 
SQL-RD will use it.  SQL-RD will also integrate well 
with most FAX server software. 

  
Q: Can I execute multiple reports simultaneously to one destination? 

A: You would have to set up multiple schedules and 
point them to the same folder 

You can do this using a Package Reports Schedule. 

  

Output Formats 

Q: What formats can the report be exported to? 

A: - XML 
- Comma Separated (CSV) 
- TIFF 
- Acrobat PDF 
- Microsoft Excel 

- Acrobat (PDF) 
- Character Separation (any character and optional 
delimiter) CSV 
- Tab separated (CSV) 
- Data Interchage Format (DIF) 
- dBase II, III and IV (dbf) 
- HTML (HTM) 
- Lotus 123 (WK1, WK2, WK4, WKS) 
- Microsoft Excel 97-2000 (XLS) 
- Microsoft Word (DOC) 
- Rich Text Format (RTF) 
- Text (TXT) 
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- TIFF (TIF) 
- Web Archive (MHTML) 
- XML (XML)  

Q: When exporting to PDF, can I set a password, or select whether the viewer can print?  

A: No Yes.  PDF security options are available and the 
resulting file will be encrypted to your specification. 

  
Q: When my manager goes to File -> Properties in the pdf or word document he has received, I want him to 

see my name as the author? 

A: Reporting Services cannot do this You can determine what is shown in the summary or 
properties of the exported file by using the File 
Summary functionality.  This is available for most 
output formats including pdf and word output. 

  
Q: My client needs the output in a CSV which uses $ instead of a comma.  Can I do this? 

A: Reporting Services cannot do this Yes. You can select any character as your separator. 
Additionally, you can override the traditional 
delimiter (") with any character or remove it 
completely.  

  
Q: Can I embed a "Confidential" stamp into the PDF output? 

A: Reporting Services cannot do this Yes. You can embed a stamp and even specify the 
font, color and other characteristics.  Why not also 
embed your company logo as a watermark? 

  
Q: Can I merge multiple reports into a single pdf file before emailing it to my manager? 

A: Reporting Services cannot do this Yes. 

  
Q: Can I specify the worksheet (tab) name in the exported excel workbook? 

A: No.  Reporting Services always names it "Sheet1" Yes.   

  
Q: I have 10 reports in the weekly report pack.  I would like them to be exported to 1 excel workbook with 

each report as a separate tab in the workbook.  

A: Reporting Services cannot do this Yes.  Use the Packaged Reports Schedule and select 
the option to merge all the constituent reports into a 
single workbook.  You can even determine the name 
that will be given to each tab. 

  
Q: Can I password protect the Excel output? 

A: No Yes 

  

Schedule Frequencies 

Q: What frequencies can I schedule? 

A: - Once 
- Hourly 
- Daily 
- Weekly 
- Monthly 
- First day of month 
- Last day of month 
- X day of nth week of month 
- Calendar 

  

- Once 
- Hourly 
- Daily 
- Weekly 
- Weekdays 
- Monthly 
- First day of month 
- Last day of month 
- X day of nth week of month 
- Calendar 
- Every day/week/month EXCEPT specified 
- When a database record is created or modified or 
deleted 
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- When a file is created or modified 
- When an email is received 
- When a windows process is present 

  
Q: I have set my schedule to run every Monday but I don't want it to run when its a public holiday.  

A: Reporting Services cannot do this. 
 
  

Use an Exception Calendar to tell SQL-RD which 
days to exclude.  

Q: The report needs to run every Wednesday.  On that day it needs to run every hour from 8am to 5 pm. Do 
I need to write a schedule for each hour? 

A: Reporting Services cannot do this. You can tell a schedule to run hourly between 8am 
and 5pm every Wednesday 

  
Q: Can I monitor a mailbox and fire off a report if an email with specified text is present? 

A: Reporting Services cannot do this. Yes. You can also read (parse) the email body text 
and use the values in it to populate other 
processes.  e.g. parameter values. 

  

Schedule Types 

Q: Can I set up a schedule of a single report? 
Can I create different schedules of the same report with each schedule having a different parameter value 
(to pull up different data) 

A: Yes Yes.  Use a Single Report Schedule.  Enter a 
different parameter value for each schedule.. 

  
Q: My monthly report pack consists of 50 reports.  Can I send all 50 reports as attachments in the same 

email, or will I get 50 emails with an attachment in each? 

A: You would get 50 emails each with an attachment 
 
  

Using a Packaged Reports Schedule, all the reports 
will be sent as attachments in a single email.  You 
can also choose to zip your reports before they are 
sent so that you receive a single email with a single 
attachment.  Packaged Reports Schedules also give 
you the option of having all the reports exported as 
tabs in a single Excel workbook, or as Bookmarks in 
a single PDF document. 

  
Q: We have 500 stores.  Every Monday each store Manager must get a sales report.  I don't want to write 

and maintain 500 schedules.  Is there another way? 

A: No.  You would have to write and maintain 500 
schedules 

Yes. Write a single Dynamic Schedule. Assuming 
your store managers' email addresses are stored in 
a database a dynamic schedule will do the following: 
 
- reel through the database,  
- populate the StoreId parameter automatically,  
- run the sales report for that store,  
- email it to the store manager using the email 
address in the database,  
 
and repeat the above actions for every store in the 
database. 
 
You can schedule this process to run every Monday. 

    
Q: Instead of running to a daily or weekly schedule, I need the report to fire off every time a new sale is 

entered in the sales database.  Can you do this? 

A: Yes, but it is not intuitive and fairly inflexible.  You 
can also only do this on database changes. 

Yes. Write an Event-Based schedule. SQL-RD can 
fire off reports based on the following events: 
 
- Database record exists 
- Database record does not exist 
- Database record has been modified 
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- Database record has not been modified 
- File exists 
- File does not exist 
- File has been modified 
- File has not been modified 
- Process exists 
- Process does not exist 
- Window is present 
- Window is not present 
- Unread email is present (POP only) 
- Unread email is not present (POP only) 
 
You can even pick up values from the database 
record or email which triggered the report and use 
these as parameter values, email addresses and 
more.  You can fully automate many of your office 
processes using Event-based schedules. 

   
Q: Can I do any other automation routines? 

A: No.  Reporting Services only runs reports. Automation schedules allow you to link and run a 
number of custom actions as an automation routine 
or "macro". 
For example,  
 
- execute an application or batch file,  
- wait 15 seconds,  
- create a folder,  
- write to a file, 
- run a report, 
- Send an email 
 
and many more... 

   

Q: Can I do any other automation routines before and after the report is exported? 

A: No Yes.  Simply set up the custom tasks you want and 
specify whether you want them to run before or 
after the report has been exported. 

   

Exception Handling and Support 
Q: What happens if the schedule errors? 

A: It times out and fails. SQL-RD will retry the schedule a number of times. 
If the schedule still fails, you can set SQL-RD to 
email a designated address, write to a log file, send 
a cellphone text or all three. This gives you an 
opportunity to resolve the problem and rerun the 
schedule even before your boss or customer knows 
there was a failure. 

Q: If the report hangs due to database traffic what happens? 

A: It times out and fails. You have the option to select “Treat as failed after x 
minutes”. This unique feature ensures that report 
then follows the “Report Failure” instruction. Thus 
ensuring that even schedules that fail as a result of 
"hanging" are recognized and processed in the 
manner required. 

   
Q: If a report fails for any reason, can it be automatically rerun? 

A: Reporting Services cannot do this. 
  

Yes, just set to retry x times on failure.  It will retry 
that many times before it finally declares a failure. 

  
Q: When a report doesn't return any data I don't want it to be emailed to the recipient. 

A: You cannot specify this in Reporting Services If the report is blank (returns no data), you can set 
SQL-RD to send an alternative email to the report 
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recipient, or another recipient. You can choose to 
attach the blank report to this email - or not. This 
ensures that recipients are aware that there was not 
data, and differentiates between a failure and a 
blank report. Alternatively you can tell SQL-RD to 
ignore the report all together and not to email 
anything to the recipient. 

  

Q: Sometimes my SMTP server times out.  Can the email be re-sent when the server is up again? 

A: You cannot specify this in Reporting Services Yes. If the mail fails to send because the mail server 
is unavailable or busy, SQL-RD can be set to retry 
automatically until successful. Mails can also be 
retried manually or deleted from the queue 
manually.  You can also increase the SMTP timeout 
value if required. 

   
Q: I have a backup SMTP server.  If the main one is down can I set the report to use the backup server 

automatically? 

A: You cannot specify this in Reporting Services Yes.  You can set up multiple SMTP servers and 
mark the ones you want to use as backup servers.  
If the main server fails SQL-RD will try each backup 
server in turn until the email is sent successfully. 

  
Q: What information is put in the error message or log entries? 

A: The error code - The pc name 
- The schedule name 
- The report name (where applicable) 
- The error that was returned 
- At what point in the process the error happened 
- An explanation of what the error means, why it 
happens and what you should do to resolve it. 

  
Q: What is support response like? 

A: Very good. 

  

Support tickets are logged through a web form.  
Support normally responds with a solution within 24 
hours.  Where necessary arrangements will be made 
to gain remote access to your PC and resolve the 
problem for you. 

 

 

 

 

 

Functionality Comparison 

 

    SQL-RD RS 

       

General     

  Max Number of Schedules Unlimited Unlimited 

  Number of Seats (Installations) permitted (Full Purchase) Per Machine CAL 

  Number of Seats (Installations) permitted (Subscription) 1 n/a 

Schedules     

  Schedule Single Reports � � 

  Schedule Packages of reports �   

  Automation Schedules �   

  Dynamic Schedules �   

  Data-Driven Schedules � � 
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  Event Based Schedules � � 

  Event Based Packages �   

Parameters     

  Single value parameter selection � � 

  Range of values � � 

  Read parameter from database �   

Parameter Functions     

  SQL-RD Functions �   

  Write your own functions � � 

Dynamic Scheduling     

  Auto populate dynamic parameter from database �   

  Pick email from same table as parameter �   

  Pick email from different table to parameter �   

  Limit schedule based on email field selection criteria �   

  Dynamic email content �   

  Auto password protect PDF output �   

  Dynamic folder hierarchy �   

  Dynamic output file naming �   

Event Based Scheduling (Triggers)     

  Database Record Exists � � 

  Database record does not exist �   

  Database record has changed �   

  Database record has not changed �   

  File Exists �   

  File does not exist �   

  File has been modified �   

  File has not been modified �   

  Process Exists �   

  Window is present �   

  Window is not present �   

  Unread email is present �   

  Unread email body text parsing �   

  Forward/Redirect unread emails �   

  
Single Condition trigger e.g if condition 'a' is true then perform 
actions �   

  
Multiple Condition trigger e.g if condition 'a' is true AND/OR 
condition 'b' is true then perform actions �   

Static Scheduling (Single reports and packages)     

  Auto Populate static parameter from database �   

  Pick email from different table to parameter �   

  Limit schedule based on email filed selection criteria �   

  Dynamic email content � � 

  Convert single schedule to package �   

  Split package into single schedules �   

Email Delivery     

  Output to email � � 
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  Max number of recipients per schedule Unlimited Unlimited 

  Silent integration with MS Outlook/Exchange �   

  Use Outlook/Exchange Address Book �   

  Use SQL-RD's Mail Server �   

  Use Single SMTP account � � 

  Use Multiple SMTP accounts �   

  Use SQL-RD's own address book �   

  Read email address from a database �   

  Read email addresses from a mailing list (text file) �   

  Add another file as attachment to email �   

  cc and bcc fields � � 

  Read Receipt Processing (Exchange/Outlook only) �   

Print Delivery     

  Output to single printer �   

  Multiple copies to a single printer �   

  Output to multiple printers (Bulk Printing) �   

  Multiple copies to multiple printers �   

File Delivery     

  Output to folder � � 

  Output to FTP folder �   

  Output to Secure FTP folder �   

FAX Delivery     

  Manual output to fax driver �   

  Automated Faxing �   

  One recipient per schedule/package �   

  Multiple recipients per schedule/package �   

Other Delivery     

  SMS (Cell Phone Text) �   

  File Transfer via RAS to a remote PC �   

Output Formats     

  MS Excel (XLS) � � 

  MS Word (DOC) �   

  Rich Text (Exact Format) (RTF) �   

  Lotus (WK1, WK3, WK4, WKS) �   

  Web Archive  (MHTML) � � 

  HTML (HTM) �   

  Acrobat (PDF) � � 

  Data Interchage Format (DIF) �   

  dBase II, III, IV (DBF) �   

  Character Separated (CSV) � � 

  XML �   

  Tiff (TIF) �   

Frequencies     

  Every day � � 

  Every week day �   

  Every Month � � 

  Every Year �   
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  Repeat every x hours until… �   

  Custom Frequency Calendars e.g 4-4-3 � � 

  Custom Exception Calendars (Don't run on specified days) �   

  Custom Recurring Options � � 

  Event Based  �   

  Export now, Deliver later (different export and delivery times) �   

DB Logon     

  db logon for main report � � 

  Logon to multiple datasources � � 

Exception Handling     

  On failure retry scheduling �   

  If report is blank do some action �   

  If report is blank, send alternative email �   

Output Options     

  Custom naming of output file �   

  Selection of date/time stamp format �   

  Custom date/time stamp for single reports �   

  Global custom date/time stamp for package �   

  Specify output extension (.xyz) �   

  Output Compression (zip) �   

  Embed output into email body �   

  Custom date/time stamp for reports in packages �   

  PGP Encryption �   

Special Excel Output Options     

  Merge a package into individual worksheets in one workbook �   

  Modify Excel File Properties e.g Title, Author, etc �   

Special PDF Output Options     

  Merge a package of multiple reports into a single PDF �   

  Password protect PDF output �   

  Watermarks in PDF output �   

Custom Actions      

  Run action after the schedule is executed �   

  Run action before the schedule is executed �   

  Run action before and after the schedule is executed �   

  Run action on successful execution of schedule �   

  Run action on successful delivery of report �   

Custom Action Types     

  Run a program (exe, com, bat) �   

  Open a document �   

  Print a Document �   

  Wait/Pause �   

  Send an email �   

  Bcc for above �   

  Open a web address �   
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  Move a file �   

  Delete a file �   

  Copy a file �   

  Rename a file �   

  Compress (zip) a file �   

  Uncompress (unzip) a file �   

  Create a text file �   

  Update a text file �   

  Copy a folder �   

  Create a folder �   

  Rename a folder �   

  Delete a folder �   

  Run another schedule/package �   

  Database - Create a table �   

  Database - Drop a table �   

  Database - Create a record �   

  Database - Delete a record �   

  Database - Update a record �   

  Execute a SQL Stored Procedure �   

  Execute a SQL script from a file �   

  Create/Write a SQL script �   

  FTP - Upload file �   

  FTP - Download file �   

  FTP - Create directory �   

  FTP - Delete Directory �   

  Secure FTP - Upload file �   

  Secure FTP - Download file �   

  Secure FTP - Create directory �   

  Secure FTP - Delete Directory �   

  Registry - Add a key �   

  Registry - Delete a key �   

  Registry - Modify a key/value �   

Automation Schedules (Macros) Actions     

  Run a program (exe, com, bat) �   

  Open a document �   

  Print a Document �   

  Wait/Pause �   

  Send an email �   

  Bcc for above �   

  Open a web address �   

  Move a file �   

  Delete a file �   

  Copy a file �   

  Rename a file �   

  Compress (zip) a file �   

  Uncompress (unzip) a file �   

  Create a text file �   

  Update a text file �   

  Copy a folder �   

  Create a folder �   

  Rename a folder �   

  Delete a folder �   
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  Run another schedule/package �   

  Database - Create a table �   

  Database - Drop a table �   

  Database - Create a record �   

  Database - Delete a record �   

  Database - Update a record �   

  Execute a SQL Stored Procedure �   

  Execute a SQL script from a file �   

  Create/Write a SQL script �   

  FTP - Upload file �   

  FTP - Download file �   

  FTP - Create directory �   

  FTP - Delete Directory �   

  Secure FTP - Upload file �   

  Secure FTP - Download file �   

  Secure FTP - Create directory �   

  Secure FTP - Delete Directory �   

  Registry - Add a key �   

  Registry - Delete a key �   

  Registry - Modify a key/value �   

Schedulers     

  Application Scheduler �   

  NT service scheduler � � 

Scalability and Administration     

  System Monitor �   

  Multi-threading �   

  SQL-RD Clustering �   

  Remote Administration � � 

  Secure User logon and profiles � � 

  SQL-RD Database stored in Access (default) �   

  Stored in local SQL installation (provided) � � 

  Stored in your own ODBC compliant database �   

  Folder Housekeeping �   

  Report history "Snapshots" �   

  Archive disabled schedules �   

  Email, Fax, File, FTP and Print in the SAME schedule �   

  More than one destination of any type in one schedule �   

  Manual system backup/restore �   

  Scheduled system backups �   

  Single schedule export/import �   

Command Line Options     

  Run schedules by command line �   

  Run packages by command line �   

  Run a system backup by command line �   

  Specify email address in command line �   

  Specify parameter values in command line �   

  Create a schedule by command line �   

 


